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BMP Import Setup Dialog Box

The BMP Import Setup dialog box opens when you choose the Microsoft bitmap option in the Import 
dialog box, then choose Setup.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the BMP Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the BMP Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 



Importing a BMP File

To import a BMP file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information



BMP Export Dialog Box

The BMP Export Dialog Box opens when you choose the Microsoft bitmap option in the Export dialog box,
then choose Setup. It lets you choose how you want the bitmap stored when it is exported.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
4-bit color Imports the bitmap with 16 colors
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors

Note: Some options are not available for this format, and you cannot select them. For example, the 
Compress option appears in this dialog box, and is grayed out. Therefore, you cannot choose the 
Compress option.

Related Topics
Procedure information 



Exporting to a BMP File

To export to a BMP file:

1. Choose the Bitmap Storage option for the bitmap you are exporting.
2. Click OK.

Related Topics
Dialog Box information



GIF Import Setup Dialog Box

The GIF Import Setup dialog box opens when you choose the CompuServe bitmap option in the Import 
dialog box, then choose Setup.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the GIF Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the GIF Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 



Importing a GIF File

To import a GIF file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information



GIF Export Setup Dialog Box

The GIF Export Setup dialog box opens when you choose the CompuServe bitmap option in the Export 
dialog box, then choose Setup.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
4-bit color Imports the bitmap with 16 colors (not available for GIF)
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors (not available for GIF)

Note: Some options are not available for this format, and you cannot select them. For example, the 
Compress option appears in this dialog box, and is grayed out. Therefore, you cannot choose the 
Compress option.

Related Topics
Procedure information 



Exporting a GIF File

To export a GIF file:

1. Choose the Bitmap Storage option for the file you are exporting.
2. Click OK.

Related Topics
Dialog Box information 



JPG Import Setup Dialog Box

The JPG Import Setup dialog box opens when you choose the JPEG bitmap option in the Import dialog 
box, then choose Setup.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the JPG Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the JPG Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 



Importing a JPG File

To import a JPG file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information



JPG Export Setup Dialog Box

The JPG Export Setup dialog box opens when you choose the JPEG bitmap option in the Export dialog 
box, then choose Setup.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Grayscale Changes colors to 256 shades of gray
24-bit RGB color Exports the bitmap with 16.8 million colors

Compression List Box
The Compression List box contains four options: Less Compression, Normal Compression, More 
Compression, and Custom Compression. 

Information is lost when you save files in the JPEG format; the more compression you use, the more 
information that is lost. The JPEG algorithm tries to throw out information that will not be noticed. The 
amount of information you lose depends on the image. Some files may not show any deterioration in 
quality even when you choose the More Compression option. Other files may show an unacceptable 
amount of deterioration when you use the higher levels of compression.

Custom Compression option
The Custom Compression option gives you more flexibility to compress your images. When you choose 
the Custom Compression option, the bottom half of the JPEG Export Setup dialog box is active. 

The Chrominance Compression area refers to the color component of the image. The Chrominance range
can be any number from 0 to 100; the higher the number, the greater the compression and the lower the 
image quality.

The Luminance Compression area refers to the non-color component of the image. The Luminance range
can be any number from 0 to 100; the higher the number, the greater the compression and the lower the 
image quality. 

The Subsampling area lets you choose from three options: Low, Medium, and High Resolution. The 
higher the resolution, the less the compression and the higher the image quality. The lower the resolution,
the greater the compression and the lower the image quality. 

Related Topics
Procedure information 



Exporting a JPG File

To export a JPG file:

1. Choose the Bitmap Storage option for the file you are exporting.
2. Choose the Compression options you want.
3. Click OK.

Related Topics
Dialog Box information



PCD Import Setup Dialog Box

The PCD Import Setup dialog box opens when you choose the Photo CD bitmap option in the Import 
dialog box, then choose Setup.

Photo CD images are images formatted in the Photo CD format and stored on compact discs. These 
images are accessed with a compact disc player connected to your computer. To the application, the 
compact disc player appears to be another drive. The images on a Photo CD can be opened like any 
other image file format.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

Resolution Options
The Resolution options let you choose 

Thumbnail
Low
Medium
High
Full

OK Button
The OK button closes the PCD Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the PCD Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 





Importing a PCD File

To import a PCD file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information



PCX Import Setup Dialog Box

The PCX Import Setup dialog box opens when you choose the ZSoft bitmap option in the Import dialog 
box, then choose Setup.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the PCX Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the PCX Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 



Importing a PCX File

To import a PCX file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information



PCX Export Setup Dialog Box

The PCX Export Setup dialog box opens when you choose the ZSoft bitmap option in the Export dialog 
box, then choose Setup.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
4-bit color Imports the bitmap with 16 colors (not available for PCX)
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors

Note: Some options are not available for this format, and you cannot select them. For example, the 
Compress option appears in this dialog box, and is grayed out. Therefore, you cannot choose the 
Compress option.

Related Topics
Procedure information 



Exporting to PCX

To export to a TGA file:

1. Choose the Bitmap Storage option for the bitmap you are exporting.
2. Click OK.

Related Topics
Dialog Box information 



TGA Import Setup Dialog Box

The TGA Import Setup dialog box opens when you choose the Targa bitmap option in the Import dialog 
box, then choose Setup.

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the TGA Import Setup dialog box and saves the configuration settings for use with 
all following translations.

Cancel Button
The Cancel button closes the TGA Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 



Importing a TGA File

To import a TGA file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information 



TGA Export Setup Dialog Box

The TGA Export Setup dialog box opens when you choose the Targa bitmap option in the Export dialog 
box, then choose Setup.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white (not available for 

TGA)
Grayscale Changes colors to 256 shades of gray
4-bit color Imports the bitmap with 16 colors (not available for TGA)
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors

Note: Some options are not available for this format, and you cannot select them. For example, the 
Compress option appears in this dialog box, and is grayed out. Therefore, you cannot choose the 
Compress option.

Related Topics
Procedure information 



Exporting to TGA

To export to a TGA file:

1. Choose the Bitmap Storage option for the bitmap you are exporting.
2. Click OK.

Related Topics
Dialog Box information



TIF Import Setup Dialog Box

The TIF Import Setup dialog box opens when you choose the TIFF bitmap option in the Import dialog box,
then choose Setup. 

Bitmap Type Options
The Bitmap Type options let you choose how you want to open the bitmap you are importing. You can 
change how a bitmap looks when you import it. For example, you can import a color image as 
monochrome. Changing an import option does not change the original bitmap file.

You can choose:

As stored Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors
32-bit CMYK color Imports the bitmap with 4.2 billion colors

OK Button
The OK button closes the TIF Import Setup dialog box and saves the configuration settings for use with all
following translations.

Cancel Button
The Cancel button closes the TIF Import Setup dialog box without saving any changes to the 
configuration settings.

Reset Button
The Reset button resets all configuration options to the state they were in at the beginning of the 
configuration session.

About Button
The About button brings up the About box which contains the version number of the translator and the 
date that it was created.

Help Button      
The Help button opens the Help file.

Related Topics
Procedure information 
TIF compatibility 



Importing a TIF File

To import a TIF file:

1. Choose the Bitmap Type for the bitmap you are importing.
2. Click OK.

Related Topics
Dialog Box information
TIF compatibility 



TIF Export Setup Dialog Box

The TIF Export Setup dialog box opens when you choose the TIFF bitmap option in the Export dialog box,
then choose Setup.

Bitmap Storage Options
Automatic Uses the same colors as the original image
Monochrome Changes the colors and shades of gray to only black or white
Grayscale Changes colors to 256 shades of gray
4-bit color Imports the bitmap with 16 colors (not available for TIF)
8-bit color Imports the bitmap with 256 colors
24-bit RGB color Imports the bitmap with 16.8 million colors

Compress Option
Choose the Compress option to use LZW compression when exporting a TIF file.

Related Topics
Procedure information 



Exporting to TIF

To export to a TIF file:

1. Choose the Bitmap Storage option for the bitmap you are exporting.
2. Click OK.

Related Topics
Dialog Box information



TIFF Compatibility

The TIF Import translator lets you import CMYK TIFF, LZW (compressed), and scatter TIF files, but not 
Motorola, CCITT (compressed), or Packbits (compressed) TIF files.

The current version of TIFF supported is version 5.0.



Using On-line Help
On-line help messages provide detailed information about commands and dialog boxes.

Accessing On-line Help

You can access help one of two ways. The first way involves pressing f1. When you press f1, 
you receive a help message specific to the command or dialog box you choose or open.

The second way involves using the Help menu. The Help menu lets you see an index of 
topics.

Jump Terms

Some help messages contain underlined words and phrases called "jump" terms. A jump 
term takes you to a related message for that term. Jump terms let you move throughout the 
help system without returning to the Help menu.

Printing Help

You can print a help message using the Print Topic command in the File menu of the Help 
window.

To print a help message:

· Choose the Print Topic command in the File menu. 

Closing Help

You can close help one of three ways.
· Double click the Control menu box in the Help window.
· Choose the Exit command in the File menu of the Help window.
· Choose the Close command in the Control menu of the Help window.
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